Lesson

| Frame the problem and
explore the study area

THE VOLATILE LOS ANGELES RIVER

is the reason America’s second-largest city was founded in its present
southern California location by Spaniards in 1781. (The arca was
originally settled by the Gabrielino Native American Tribe thousands
of years earlier.) Its water was tapped for drinking and irrigation, and
a new city spread out from the river across the coastal plain. By the
turn of the 20th century, the river was surrounded by a thriving urban
center. Every few decades, raging floods would crest the banks at various
points, submerging entire neighborhoods. After the historic floods of
1938 that claimed more than 100 lives and washed out bridges from
Tujunga Wash to San Pedro, city leaders had seen enough. By 1941
the U.S. Army Corps of Engineers began to straighten, deepen, and
reinforce the once wild waterway. Much of its length was eventually
lined in concrete, and the river was more or less tamed.

Today, the City of Angels—home to nearly 4 million people—is
a vibrant world center of business and culture. Running straight
through the heart of the city, the Los Angeles River now serves ably as
aflood-control channel. Sadly, this once-bucolic waterway that was so
instrumental in the formation of the city became known as something
ugly and marginal. Mile after mile of angled concrete appealed only
to grafhti artists and filmmakers, and save for the occasional televised
rescue of some hapless Angeleno swept away by a winter storm-fed
torrent, the river remained a part of the city ignored by most. The
negative perception has stuck with the neglected river for decades.

But in recent years, as the city has densified and much of southern
California’s wildlands have been appropriated for development, new
attention has focused on the river corridor and the scattered pockets
of open space that line its length. While it must always serve its
important flood control function, the river and adjacent lands are
increasingly recognized as under-utilized, providing opportunities for
regreening and psychic restoration for human beings in an overbuilt
city. Adventuresome and resourceful citizens have discovered peaceful
pockets of sanctuary along the river and made these places their own.
A vital and concerned activist community has raised awareness of the
river and pushed for its beautification and redevelopment.
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In 2005, the city launched a major public works project focused
on the human dimensions of the river. A landmark study, the
Los Angeles River Revitalization Master Plan, demonstrated the
significant potential to improve quality of life for citizens living
near the river corridor through wise redevelopment. Mayor
Antonio Villaraigosa said at the time: “We have an opportunity
to create pocket parks and landscaped walkways...to create places
where children can play and adults can stroll.”

According to Villaraigosa, “The Plan provides a 25- to 50-year
blueprint for transforming the City’s 32-mile stretch of the river
into an ‘emerald necklace’ of parks, walkways, and bike paths,
as well as providing better connections to the neighboring
communities, protecting wildlife, promoting the health of the
river, and leveraging economic reinvestment.”

While the 2005 master plan identified some of the most obvious
areas for large-scale regional redevelopment along the river,
it stopped short of identifying smaller (and more affordable)
neighborhood projects; that work would require a more involved
study. With thousands of land parcels strung out along the river,
identifying the best places for park development is like looking for
that proverbial needle in a haystack. Many factors come into play,
among them current land use, demographics, and accessibility.



In the years since the plan’s completion, the city has created a web
site that encourages people to learn about (and participate in) the
latest developments related to its landmark resource. The web site at
www.lariver.org contains links to many resources about the river
and its watershed, including scientific studies and recreational
opportunities. If city leaders can find the resources and a motivated
citizenrykeeps up the pressure, there will be a renaissance transforming
growing stretches along the river that become real versions of these
artists’ renderings.
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Here’s where you pick up the thread in this book. You’ll use the city’s
real need for river redevelopment as a launching point for a park
siting analysis using a geographic information system (GIS). A GIS is
ideal for this type of decision-making because it allows you to analyze
large amounts of data in a spatial context. In this book, you'll spend a
lot of time with Esri’s ArcGIS® for Desktop software, and by the end
you’ll have completed a project from start to finish. Along the way,
you’ll gain an excellent grasp of what a GIS can do.

You'll be assuming the role of a GIS analyst for the City of Los
Angeles. So what exactly does a GIS analyst do and how is that job
different from other jobs that also use GIS software? The table below
defines some of the various roles that a typical GIS operation might
establish to accomplish their work.

GIS Roles

Editors People who create, update, and correct spatial data and
its attributes (statistical and descriptive information).

Cartographers People who make and publish maps and solve
information design problems.

Analysts People who query and process geographic data to
solve analytical problems.

Programmers  People who implement custom GIS functionality by de-
veloping scripts and applications for specific procedures.

Managers People who oversee staffing and equipment, database
design, workflow, new technology, and data acquisition.

The central work in this book is analytical. Your main focus will be
on using ArcGIS tools and methods to find the most park-suitable
land within a study area, but there is preparatory work to do before
the analysis proper, and there are results to interpret and present
afterwards. This book has two goals. One is to present a comprehensive
approach to geographic problem solving. We want to help you develop
skills, habits, and ways of thinking that will be useful in projects other
than this one. The second goal is to teach you how to use ArcGIS 10.1
for Desktop software. These goals are mostly complementary. ArcGIS
is a big system, however, and it wouldn’t be realistic to try to cover all
it can do in a single book. Our principle has been to teach the software
in the service of the project and not otherwise. You'll delve into many
aspects of ArcGIS for Desktop—editing, modeling, and cartography
among them—but there are other aspects we won't use, or will only
touch lightly, because they arent strictly relevant to our needs. We
might say (with apologies to Waldo Tobler) that everything in a GIS
is related to everything else, but some things are more closely related to
analysis than others.



Frame the problem

The first step in the geographic approach to problem-solving is to
frame the problem. What that means, first of all, is coming up with a
short statement of what it is you want to accomplish. We want to find
a suitable site for a park near the Los Angeles River.

Once you have the statement, you can begin to tease out its
ambiguities. What factors make a site “suitable”? Fortunately for us,
the city council has already established a concise and fairly specific
set of guidelines. They want a park to be developed:

* On avacant parcel of land at least one acre in size

* Within the Los Angeles city limits

* As close as possible to the Los Angeles River

* Not in the vicinity of an existing park

* In a densely populated neighborhood with lots of children
* In alower-income neighborhood

* Where as many people as possible can be served

This limits the scope of our inquiry, but it’s far from a complete
breakdown of the problem. Some of the guidelines are specific, but
others are vague. Familiar concepts are sometimes the hardest to
pin down. For example, what income level should count as “lower
income”? How are the boundaries of a “neighborhood” established?
We can’t solve the big problem until we’ve solved the little problems
buried inside it. Usually, however, it’s not possible to address (or even
foresee) all the little problems ahead of time.

Data exploration influences the framing of the problem. Do you have
income data on hand? If so, is it for individuals or households? Is it
average, median, or total? To the extent that the questions themselves
are indefinite (what is lower income? how should it be measured?),
the data you have available will help shape the answer.

Analysis also influences the framing of the problem. Given that
we want a one-acre tract of vacant land, what do we do about
adjacent half-acre lots? Is there a tool to combine them? If so, does
it have undesired side effects, such as loss of information? Our data-
processing capabilities (and our knowledge of them) may determine
how we define a “one-acre parcel.”

Even the results of an analysis influence the framing of the problem.
Suppose, after having carefully defined the guidelines, we run the
analysis and don’t find any suitable sites. Do we report to the city
council that there’s just no room for a park anywhere? More likely, we
change some of our definitions and run the analysis again.

Framing the problem, therefore, is an ongoing process, one that will
occupy us through much of the book.
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Exercise la: Explore the study area

In this exercise, we’ll get to know the Los Angeles River and its
surroundingarea with maps and data. At the same time, we’ll learn the
basics of working with ArcMap: how to navigate a map, how to add
and symbolize data, and how to get information about map features.

1) Start ArcMap. We'll open the ArcMap application.

O Click the Windows Start button and choose All Programs
—> ArcGIS > ArcMap 10.1.

The application opens with the ArcMap - Getting Started dialog box
in the foreground (Figure 1-1).

O In the left-hand window, if necessary, click My Templates.
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Figure |-1

© Click the Blank Map icon to select it and click OK.

A blank map document opens. A map document is a file that contains
one or more maps, layouts, and associated layers, tables, charts, and
reports.

2) Addabasemap layer. A basemap is a layer of reference geography
that forms a backdrop to your map.

© On the Standard toolbar at the top of the application window,

locate the Add Data button .

O Click the small drop-down arrow next to the button.

> If you click the icon instead of the arrow, an Add Data dialog box
will open. Close this dialog box and try again.

© On the drop-down menu, choose Add Basemap.



Figure 1-2

© In the Add Basemap window, click Szreets to select it
(Figure 1-2), then click Add.
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You'll probably be prompted to enable hardware acceleration. (It
depends on your computer configuration.)

@ Ifyou’re prompted to enable acceleration, click Yes.

This book makes frequent use of online map services; specifically the
Streets and Imagery basemaps. One side effect is that there can be
complications due to servers, web and network connections, and the
processing power of your computer. Therefore, operations in some
cases may be slower than you anticipate. Be reasonably patient as you
work, and check the Understanding GIS web site (see page xii) for

updated information if performance issues persist.

The World_Street_Map basemap layer is added to your map
document (Figure 1-3). It has an entry in the Table of Contents
window on the left. At the top of the application is
the main menu. Underneath it are two toolbars. The

T
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Standard toolbar has generic functions (such as New,
Save, Print, Copy, Paste) and buttons to open other
windows. The Tools toolbar has navigation tools
(such as Zoom In, Zoom Out, and Pan) and other
1 common tools for doing things with maps. There are
lots of other toolbars besides these, and we’ll use a
£ couple of them in this lesson.

On the right side of the application are two tabs
named Catalog and Search. These tabs are hidden
windows. We’ll use both windows a lot in the book,
although we won’t get to the Search window for a few
more lessons.

FETNTIEEE ]



Toolbars and windows can be moved around and resized. Figure |-4
Figure 1-3 reflects the default arrangement. P

3) Zoom in to Southern California. We’ll zoom in to
our area of interest.

© On the Tools toolbar, click the Zoom In tool #, .
. . Draw a box

In the map window, click and drag to draw a box
. . o around the area
around Southern California, as shown in Figure 1-4. you want to

> Your box doesn’t have to match exactly. zoom to.

© Use the Zoom In tool again to get closer. When you
see city names and major roads, use the Pan tool ™M
to center the view on the Los Angeles area.

© Keep zooming in (try the Fixed Zoom In
button a x, too) until you can easily LT
distinguish cities, freeways, and i
landmarks such as airports, as in Figure 1-5.

> If you zoom in further than you want, use the {"'H
Zoom Out =}, or Fixed Zoom Out §J tools .22

to go back.

You probably noticed that no streets were visible
at the global scale, and that as you kept zooming
in, more and more detail appeared. This is because
the basemap is a multiscale map: really a set of
maps which turn themselves on and off to display
features and symbology that are appropriate to
your map scale.

Figure 1-5 shows greater Los Angeles, an area that
includes hundreds of incorporated communities
and nearby cities. Figure 1-5

Basemap layers

Basemap layers show reference geography such as street maps, imag-
ery, topography, and physical relief. The ones available from the Add
Basemap window in ArcMap®are remotely hosted map servicesthat you can
navigate, view, and use as backdrops to other data. Basemaps are stored
at multiple scales, so that as you zoom in or out you see different amounts
of detail. As you navigate a basemap, the various pieces of it (called tiles)
that compose your current view are stored locally on your computer in
a so-called display cache. VWhen you zoom or pan to a new area, the map
may be a little slow to draw, but any place you return to will redraw quickly
because the data comes from your cache, not from the remote server.

Explore the study area
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conoect Tarokder x| 4) Add a layer of project data. On top of the basemap, we’ll add a

Choose the fokder 10 wihch you mar 10 cormect; layer from the data that has been put together for this project and is
stored on your computer. In Lesson 2, we’ll talk more about where
g Eﬁm = this data comes from and how to acquire data of your own.
ZerEnnih . © On the Standard toolbar, click the Add Data button <.
Lste This time, click the icon itself, not the drop-down arrow.
Wikt &

The Add Data dialog box opens to a default “home” location in your
Documents\ArcGIS folder. We don’t have any project data here. To
s i Pier | o | ewe | navigate to our data folder, we have to make a folder connection.

Fooiche ; [::mu

Figure 1-6 © In the row of buttons at the top of the Add Data dialog box,
click the Connect To Folder button £%.
© In the Connect To Folder dialog box, navigate to the folder
where you installed the data—probably C:\UGIS—
(Figure 1-6) and click OK.
© In the Add Data dialog box, navigate as follows:
* Double-click the ParkSite folder to open it.
* Double-click the Source Data folder.
* Double-click ESRI.gdb.
* Double-click Boundary.

We'll discuss GIS data formats in the topic Representing the real
world as data in Lesson 2. For now, we just want to dig down to our
data.

@ In the Add Data dialog box, click Cizy_ply to select it
(Figure 1-7) and click Add.

> Or just double-click Cizy_ply from the list.

=
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Figure -7




A layer of city boundaries is added to the map (Figure 1-8). Each city
in the layer is called a feature. These features are polygons, which
are one of the three basic shapes with which geographic objects are
represented in a GIS. (The others are lines and points.)

CFE B e Geeeess  Pee SRR Geoeiteed  LSees  Geees e
Cald & ke . 0w [5E5% Hu B TREO =y
(R e -0 kDS w-:-nm-s_.m ]

EETED

AR

The color of the
layer is assigned
at random, so
yours may be
different.

= Figure 1-8

In the Table of Contents, the order of entries matches the drawing
order of layers in the map. City_ply is listed above Basemap, and
on the map, the cities cover the basemap. You can control a layer’s
visibility with its check box in the Table of Contents.

@ In the Table of Contents, click the check box next to Cizy_ply.
The layer turns off.

Table Of Contents

O Click its check box again to turn the layer back on. 888
SE= rs
5) Set layer properties. Every layer has properties you can e Ev:ity _ply
set and change. For example, you just changed the visibility I__EE’-F o Clor l
property of the City_ply layer. Richeclick IDDO00000O0E0
O In the Table of antents, right-click the color patch |ghe;ce|c 5: : E S E E E : : : :
underneath the Cizy_ply layer name. IEEEDEEEEEN
. . . ENEEEEEEEEEN
A color palette opens (Figure 1-9). Moving the mouse pointer EEEEEEEEEEER
over any color square shows its name as a tool tip. ENO000000O0@E®E@
BEEOCO0O0OO0OO0D N NN
© On the color palette, click any color you like to change EEENO00CDCEEEE
the layer color. ENENEEEEEEER
On the map, the cities redraw in the color you chose. Hore Colorse
Figure -9

Explore the study area ||



@ In the Table of Contents, right-click the Cizy_ply layer name
to open its context menu. At the bottom of the menu, choose
Properties.

The Layer Properties dialog box opens. This is where you access the
tull set of properties for a layer.

© If necessary, click the General tab (Figure 1-10).

Each tab along the top has
different layer properties.

Figure I-10

The layer’s name, City_ply, is one of its properties. This name is
cryptic (it stands for “city polygons”) and unattractive, so let’s change
it.

@ In the Layer Name box, delete the name and type Cities
instead. Click Apply.

The name is updated in the Table of Contents.
@ In the Layer Properties dialog box, click the Source tab.

This tab shows technical information about the layer, including the
path to the data on your computer (Figure 1-11).

Figure I-11

Lesson |: Frame the problem and explore the study area



Renaming the layer in the map document doesn’t change the name
associated with the source data (which is still Cizy_ply). A layerisa
representation or rendering of the data, not the data itself. You can
make any changes you want to a layer’s properties without affecting
the data on which the layer is based.

O Click OK on the Layer Properties dialog box to close it.

6) Get information about cities. Let’s see what we can find out
about the cities on the map.

© On the Tools toolbar, click the Identify tool .
© Click any city polygon on the map.

The city flashes green and an Identify window opens (Figure 1-12).
In the top window, you see the name of the city you identified. In the
bottom window, you see its attributes, or the information that this
layer stores about cities. Some of them aren’t obviously meaningful,
but others are. If POP2010 is population for the year 2010, and
POPI10_SQMI is population per square mile for the same year,
then you know that Los Angeles (if that’s the city you identified)
had 3,792,621 inhabitants at the time of the 2010 census and its
population density was 8,018 people per square mile.

© Move the Identify window away from the map, if necessary.
Click another city on the map.

The Identify window updates with information about the new city.
All the cities have the same set of attributes; it’s the values of the
attributes that change.

© Identify a few more cities, then click somewhere on the basemap
where there isn’t a city.

The Identify window is empty and a message at the bottom says, “No
identified features.”

® Close the Identify window.

©® In the Table of Contents, right-click Cities and choose Open
Attribute Table (Figure 1-13).

Easl fenehils
Aharrary
Heema 15

- -
El- City_ply
i Los Angeles
[&|[
Location: [ -13,165,662.200 4,032,705.902 Meters 4
Field | Value
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Shape Palygon
MAME Los Angeles <
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5T CA
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PLACEFIPS 44000
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This example shows
Los Angeles, but it
doesn’t matter which
city you identify.

Figure I-13



2. Click the box
to select
the record.

© Scroll across the table and look at the field names (the gray

column headings).

This is a different presentation of the same information you saw
when you identified cities.

© Scroll back to the beginning of the table, then scroll a little way
down through the records (the table rows).

There are a lot of records in this table: in fact, 29,259 of them, as you
can see at the bottom. Each corresponds to a unique feature—that is,
a unique city—on the map. So there must be a lot of cities we’re not
seeing in the current view.

© Leave the table open, but move it out of the way of the map.

> You can dock it by dropping it on any blue arrow, or you can
move it outside the ArcMap application window.

© In the Table of Contents, right-click the Cities layer. On the

context menu, choose Zoom To Layer.

The map zooms out to the geographic extent of the layer: the entire
United States. You can’t distinguish individual cities at this scale.

® On the Tools toolbar, click the Go Back To Previous Extent

button 4.

7)  Select the record for Los Angeles. When you select a record in
an attribute table, the corresponding feature is selected on the map.
(Likewise, when you select a feature on the map, its record is selected

in the table.) Selections are marked with a blue highlight.
O Scroll up to the top of the table. Make sure the table is wide
enough that you can see the POP2010 field.
> If necessary, widen the table by dragging its edge.

O Right-click the POP2010 field name. On the context menu,
choose Sort Descending.

The records are sorted in the order of their populations, from largest
to smallest. Los Angeles is now the second record in the table, right

after New York.

O At the left edge of the table, click the small gray box next to the
Los Angeles record to select it (Figure 1-14).
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On the map, the city of Los Angeles is
highlighted in blue. You may be able
to see the whole city already, but let’s
make sure.

©® Close the attribute table.

@ In the Table of Contents, right-
click Cities and choose Selection >
Zoom To Selected Features.

The map zooms in close on the selected
feature and centers it in the view
(Figure 1-15). The city’s odd shape
is attributable to years of piecemeal
expansion and incorporation. It has
internal “holes” where it surrounds
other cities, such as Beverly Hills, or
unincorporated areas. It also has a
long, narrow southern corridor that
connects it to its harbor at the Port of
Los Angeles. Figure 1-15

@ On the Tools toolbar, click the Clear Selected Features button [
to unselect the feature.

8) Filter the display of cities with a definition query. One of our
project requirements is that the new park be inside the Los Angeles
city limits. Therefore, we’re more interested in Los Angeles than in
other cities. A layer property called a definition query lets us show
only those features in a layer that interest us.

O In the Table of Contents, right-click the Cizies layer and choose
Properties.

O In the Layer Properties dialog box, click the Definition Query
tab.

O Click Query Builder to open the Query Builder dialog
box (Figure 1-16).

The completed query will
be shown in this box.

Click here to start
building the query.

Figure |-16
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The expression

You build a query on an attribute table by specifying a field and
setting a logical or arithmetic condition that values in that field have
to satisfy. In our case, we want to find records with the value “Los
Angeles” in the NAME field.

© In the list of field names at the top of the Query Builder dialog
box, double-click “NAME.”

The field is added to the expression box at the bottom of the Query
Builder.

O Click the Equals button .
@ Click Get Unique Values.
The middle box in the Query Builder is populated with a list of all

the city names in the NAME field. Since there are so many, it would
be inconvenient to scroll to the one we want.

O Click in the Go To box and start typing Los Angeles.

By the time you get to “Los An” the value “Los Angeles” will be
highlighted in gray.
© Double-click Los Angeles.

© Compare your expression to Figure 1-17. If it doesn’t match,

click Clear and rebuild it.
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ok | Cancel |

Figure I-17

© Click Verify and click OK on the Verifying Expression message

box.

> If you get an error message, click OK. Clear and rebuild the

expression.

0 Click OK on the Query Builder dialog box.



The expression appears on the Definition Query tab (Figure 1-18).
O Click OK on the Layer Properties dialog box.

On the map, only the city of Los Angeles is shown. The other cities
are hidden by the definition query (Figure 1-19).

@ In the Table of Contents, right-click the Cities layer and choose
Open Attribute Table.

The table shows just the record for Los Angeles.
O Close the attribute table.

The other city features haven’t been deleted. Clearing the definition
query would display them again. Layer properties affect the display
of data in a map, not the essential properties of the data itself: the
number of features, their shapes, locations, and attributes.

Layers and datasets

A layer points or refers to a dataset stored somewhere on disk (as speci-
fied on the Source tab of the Layer Properties dialog box). A layer is not a
physical copy of the data. A layer is a representation or rendering of the
data. The dataset stores the shapes, locations, and attributes of features;
the layer stores display properties, including what the layer is named, which
of its features are shown or selected, how those features are symbolized,
and whether they are labeled. Changes to layer properties do not affect
the dataset that the layer refers to. You can make as many layers as you
want from the same dataset and give them different properties. These
layers can coexist in the same map document or in many different map
documents.

Definition Query:

"MAME™ = 'Los Angeles'

Figure 1-19

Figure -18

Explore the study area
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Identify

Identify from:

9) Add alayer of rivers. Let’s add a layer of local rivers to the map
and see where the Los Angeles River fits into the picture.

O On the Standard toolbar, click the Add Data button [#]. (Click

the icon itself, not the drop-down arrow.)

The Add Data dialog box opens to your last location. There’s no river
data here.

© In the row of buttons at the top of the Add Data dialog box,
click the Up One Level button 4& (Figure 1-20).

Figure 1-20

Look in: ILjESRI.gdb j &

Boundary
Hydro

Landmark
Transport

© Double-click Hydro.
© Click River to select it and click Add.

A layer of rivers is added to the map and placed at the top of the Table

of Contents.

® On the Tools toolbar, click the Identify tool @, if necessary.
® Click on any river to identify it.

You see the name of the river (many of them don’t have names) and

[ B - | it other atcributes (Figure 1-21).

El-River

‘- Caballero Creek

By default, the Identify tool identifies features from the topmost layer
in the Table of Contents. If you miss a river, you'll either identify
aml  the City of Los Angeles or nothing. That’s fine—leave the Identify

4| window open and click again on a river.

Shape_Length

1]

Location: | -13,194,814. 162 4,051,688.258 Meters
Field | Value

OBIECTID 2211

Shape Palyline

NAME Caballero Creek

TYPE StreamRiver

DESCRIPTION | Intermittent

METERS 4530

FEET 15157

0.042473

O Click on a few more rivers to identify them. Try to identify a
segment of the Los Angeles River.

The river runs west to east across the city, turns south near the city’s
eastern edge, and follows a freeway to San Pedro Bay.

© Close the Identify window.

10) Make a definition query on the LA River. Just as we’re mainly
interested in one city, we're mainly interested in one river. We'll
| »y| makeanother definition query to show just the Los Angeles River.

|Idenh’ﬁed 1 feature

Figure |-21

O In the Table of Contents, right-click the River layer and choose
Properties.
> A shortcut is to double-click the layer name in the Table of
Contents.



© Click the Definition Query tab, if necessary. x|
O Click Query Builder to open the Query Builder dialog box. e jd
© In the list of field names at the top of the Query Builder o oo
dialog box, double-click “NAME.” "METERS" -
@ Click the Equals button [ - J. = | <> | [uie | [ et Dalton wash' |
‘Little Rock Creek’
@ Click Get Unique Values. 2 =] nd | | e o was =
O Click in the Go To box and start typing Los Angeles | Lo fogos e .
River. A | s

Is | et Unigue Yalues |Go To: ILos ang

SELECT * FROM River WHERE:

© Double-click Los Angeles River. I3 S i

© Compare your expression to Figure 1-22. If it doesn’t match,
click Clear and rebuild it. -]

Clear Veiy | Hep | losd. | Save.. |

The value will be highlighted in gray before you finish typing.

L

© Optionally, verify the expression.
0 Click OK on the Query Builder dialog box. Ok__]__ Cancd
© On the Layer Properties dialog box, click the Symbology tab. Figure 1-22

@ On the Symbology tab, click the button displaying the blue line
symbol to open the Symbol Selector.

© Change the line width to 3 (Figure 1-23) and click OK on the
Symbol Selector.

Ganesal | Scuch | Setsoton | Disply| 5oty | Fiskds | Dafition Guesy | Libals | Jor Figure 1-23
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® On the Layer Properties dialog box, click the General tab.
@ In the Layer Name box, delete the layer name River and type Los
Angeles River (Figure 1-24).
> You can also rename a layer directly in the Table of Contents by
clicking the name once to highlight it and clicking it again. (Be
careful not to double-click or you'll open the layer properties.)
Figure 1-24 [
Goronw | Sousce | Sukcton | D | Syl | ke | Dubitin oy | Lt | e & i | Tom | 111
Laper ot | [t Angeies Rrcer | F vieisie
Brwrpon: U, NS S e oasonis duas Hotes a0 b 4, s Ul |

© Click OK on the Layer Properties dialog box.

On the map, the river is displayed with its new symbology
(Figure 1-25). The Table of Contents reflects the new layer name.

11) Select Los Angeles River features with a query. On the map,
the river looks like a single feature (just like the city), but it’s not.

O In the Table of Contents, right-click the Los Angeles River layer
and choose Open Attribute Table.

At the bottom of the table, you see that 0 of 17 records are selected.
That means that, in this particular layer, the Los Angeles River is
composed of 17 features. Why would that be?

O Scroll down through the table.

All the records have the same NAME value. Most have the same TYPE,
but one is an artificial path. There are a few DESCRIPTION values.
The need to maintain different attribute values for different parts of
a geographic object is a common reason that data—especially data
wwn representing linear features such as streets and rivers—is constructed
Figure 1-25 this way (Figure 1-26). We'll come back to this point in the next
lesson.

Figure 1-26 |FEE o x

ERIE- R R

OBJECTID*| Shape* NAME TYPE DESCRIPTION | METERS | FEET | Shape_Length | «
2191 | Polyline Los Angeles River |Stream/River Perennial 11473 | 37558 0.12056
2192 | Polyline Los Angeles River |Stream/River Perennial 1278| 4184 0.013569
2200 | Polyline Los Angeles River |Stream/River Intermittent 1911 6256 0.020294
2203 |Polyline Los Angeles River |Stream/River Intermittent 1362 | 4459 0.014402
2205 | Polyline Los Angeles River |Stream/River Intermittent 1631 5339 0.017653
2217 | Polyline Los Angeles River |Stream/River Perennial 4077 | 13346 0.043274
2218 |Polyline Los Angeles River |Stream/River Perennial 2303| 7539 0.024279%
2275 | Polyline Los Angeles River |Stream/River Intermittent 3961 | 12967 0.042332
2345 | Polyline Los Angeles River |Stream/River Perennial 10147 33217 0.0974
n 2410 | Polyline Los Angeles River |Stream/River Perennial 2452 | 8027 0.026543 ;I
44 17 r n |§| (0 out of 17 Selected)
Los Angeles River

Lesson |: Frame the problem and explore the study area



© In the row of tools at the top of the table window, click the x]

Select By Attributes button .

Having noticed “perennial” and “intermittent” values in the
DESCRIPTION field, we might want to know which parts of the
river are which. We can find out with an attribute query. An
attribute query is like a definition query in that both single out
features in a layer on the basis of attribute values. The difference
is that an attribute query highlights (selects) features that satisfy
the expression rather than hiding features that don’t.

© At the top of the dialog box, make sure the Method drop-

down list is set to “Create a New Selection.”

@ In the list of field names, double-click “DESCRIPTION” to
add it to the expression box.

® Click the Equals button [ - J.
O Click Get Unique Values.
© In the list of unique values, double-click ‘Perennial’

© Confirm that your expression matches the one in

Enter a WHERE clause to select records in the table window.

Method : ICreate a new selection j
"OBJECTID" -4
"MAME"

"TYPE"
"DESCRIPTION"
"METERS" ;l

Lo | [ | (o | [t

| o |

= o]

x| o ma]

il (et Wnigue Yalues |GnTn: l—

SELECT = FROM River WHERE:

Figure 1-27 and click Apply.

Twelve records are selected in the table. The corresponding features
are selected on the map, showing you that the river is perennial for
most of its length (Figure 1-28).

It’s not among our guidelines to locate the new park along the river’s
perennial stretch, but it’s interesting that fairly simple data exploration
may introduce new ways of thinking about your problem.

© Close the Select By Attributes dialog box.
© At the top of the table window, click the Clear Selection button
.
Clearing the record selection clears the feature selection on the map.
(The reverse is true as well.)

O Close the attribute table.

Selecting features

You make selections in order to work with a subset of features in a layer.
You can use a selection to zoom the map in to a specific area, to make a
new layer from the selected subset, to get statistical information about the
subset, or for many other things.

Selections are also used in queries. Whether you do an attribute query
(to find records with a certain attribute value) or a spatial query (to find
features with a certain spatial relationship to other features), the records
and features that satisfy the query are returned as a selection on the layer.

"DESCRIPTION" = Perennial =
[

Cor | ety | oo | _towt. | _som|
Figure |-27
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Click here
to navigate

The selection and arrangement of
basemaps is subject to change, so
your screen may look different.

12) Save the map document. This is a good time to save the map
document. Save your maps often as you do these exercises—don’t
wait to be reminded.

® On the Standard toolbar click the Save button [&.

In the Save As dialog box, ArcMap should default to your My
Documents\ArcGIS folder. In this book, we’ll save most of our maps
to the ParkSite\MapsAndMore folder.

O In the panel of icons on the left side of the dialog box, click
Computer.
© Navigate to C:\UGIS\ParkSite\MapsAndMore.

© When you're inside the MapsAndMore folder, replace the de-
fault file name with Lesson1 (Figure 1-29) and click Save.

I =
B | L Mo oY =&

Larcs

Figure 1-29

13) Add a basemap of imagery. Imagery provides a detailed,
photorealistic view of the ground, and we’ll rely on it to explore the
LA River in more detail. Imagery also has other important uses, such
as providing a background against which to edit features (Lesson 5),
and “ground-truthing” analysis results (Lesson 6).

© On the Standard toolbar, click the drop-down arrow next to the
Add Data button and choose Add Basemap.

O In the Add Basemap window, click Imagery with Labels to select
it (Figure 1-30) and click Add.
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Figure 1-30



The World_Imagery basemap layer is added to the bottom of the
Table of Contents. You don’t see it on the map because it’s covered
by the basemap of streets. A layer called Reference has simultaneously
been added to the top of the Table of Contents. This layer consists of
locations, boundaries, and labels and should be visible on the map.
(You should see yellow place-names covering the city of Los Angeles
feature, for instance.).

> If you don’t see these labels, click the Refresh button ## in the
lower left corner of the map window.

We don’t need two basemaps in the map, so we’ll remove the basemap
of streets.

O In the Table of Contents, right-click the name Basemap above
World_Street_Map (Figure 1-31) and choose Remove.

The basemap is removed and the imagery is now visible. Your Table
of Contents and map should look like Figure 1-32.

Magrpark Simi Vallay]

Thatizsand

Here the Table of |MEASASIEIIS .
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screen. World_Imagery

Figure 1-31
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x|| 14) Create a bookmark. Certain views in a map are useful for

orientation or reference. You can bookmark a view to make it
easy to return to.

Bookmark Name: ICrty of Loz Angeles

ok | Cancel )
® From the main menu, choose Bookmarks —> Create

Figure 1-33 Bookmark.
O In the Create Bookmark dialog box, replace the default name
with City of Los Angeles (Figure 1-33). Click OK.
O Use the Zoom In tool # to zoom in on the river’s mouth in the

harbor at Long Beach.

© On the Standard toolbar, click the Map Scale drop-down arrow
and choose 1:10,000 (Figure 1-34).

1:5,000
1:1.000

1:24.000
1:100.000
1:250.000
1:500.000
1:750.000
1:1,000,000
1:3,000,000
1:10.000.000

<Custornize This Lis | At this scale, one unit of

measure on the map is
equivalent to ten thousand
of the same units on the
ground. Loosely, a thing on
the map is ten thousand
times smaller than its
actual size.

Figure 1-34

® Use the zoom and pan tools to explore the harbor.

The imagery is very high resolution and you’ll see more detail as you
keep zooming in. Eventually, you'll reach a limit.

® When you're ready, from the main menu, choose Bookmarks -

City of Los Angeles.

The map view returns to the bookmarked extent.

Lesson |: Frame the problem and explore the study area



15) Change the symbology for Los Angeles. The boundary of Los
Angeles is filled in with a solid color, so the imagery underneath is still
covered up. Pretty soon we're going to zoom in and follow the river’s
course through the city. It will serve that purpose to resymbolize the
city so that we just see its outline.

©® Open the layer properties for the Cities layer. Click the
Symbology tab, if necessary.

© On the Symbology tab, click the button displaying the current
color symbol to open the Symbol Selector.

© In the Symbol Selector, click the Fill Color button to open the
color palette.
> You can click either the color square itself or the drop-down
arrow.

© At the top of the color palette, click No Color.
This will make the symbol transparent.

® Change the Outline Width value to 2.

® Click the Outline Color button. On the color palette, click
Autunite Yellow (Figure 1-35).
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Figure 1-35
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Figure 1-36

Figure |-37

O Click OK on the Symbol Selector. Click Apply on the
Layer Properties dialog box and leave it open.

The new symbology is displayed on the map (Figure 1-36).

® Click the General tab and rename the layer Los
Angeles.

© Click OK on the Layer Properties dialog box.

16) Save the layer as a layer file. It wasn’t hard to make this
particular symbol, but often it does take time and effort
to create good symbology. Having done so, you may want
to reuse that symbology. In this book, for instance, we’ll
draw the outline of Los Angeles in other map documents
in coming lessons.

You can save layer properties to a file called a layer file, which has
the file extension ./yr. A layer file is not a copy of the data, but you
add it to a map document in the same way that you add data. The
layer file stores all the properties of a layer—name, symbology,
definition query, and so on—including the path to the layer’s source
dataset. When you add a layer file to ArcMap, the layer draws with
its properties already set.

O In the Table of Contents, right-click Los Angeles and choose Save

As Layer File (near the bottom of the context menu).

The Save Layer dialog box opens to the ParkSite\MapsAndMore
folder (Figure 1-37).

© Accept the default name Los Angeles.lyr and click Save.
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When you saved the map document in
the MapsAndMore folder, this became
the map’s “home” folder. Now other
files associated with the map, such as
layer files, will be saved to this location
by default.
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We'll remove the Los Angeles layer that’s currently in the map, then
add the layer file to see how it works.

© In the Table of Contents, right-click Los Angeles and choose

Remove.
The layer disappears from the map and the Table of Contents.

® On the Standard toolbar, click the Add Data button.

O In the Add Data dialog box, click the Look in: drop-down arrow
and click the ParkSite folder (Figure 1-38).

® In the dialog box, double-click the MapsAndMore folder.
O Click Los Angeles.lyr to select it (Figure 1-39) and click Add.

Look in: IEI MapsAndMore j &y

Figure -39

The layer is added to the map with its properties set.

© Open the layer properties for Los Angeles. In the Layer Properties
dialog box, click the Source tab.

As before, the layer points to the Cizy_ ply feature class.
© Close the Layer Properties dialog box.

Anytime you add the Los Angeles.lyr file to a map document, the
layer will draw as a yellow outline with a definition query on the city
of Los Angeles. Once the layer has been added to the map, however,
it’s just the same as any other layer, and you can change its properties
however you want. (Not that you want to change them.)

17) Follow the river. Let’s start developing a sense of the study area
by following the river’s course through the city.

O Maximize the ArcMap window if you haven’t done so already.

® Use the Zoom In tool to zoom in on the river’s source in the
community of Canoga Park in northwest Los Angeles.

The river officially starts where Bell Creek and the Arroyo Calabasas
converge at Canoga Park High School.

©® On the Standard toolbar, click the Map Scale drop-down arrow
and choose 1:24,000.

Look in:

ﬁ Hydro

=l &

W @ Home - ParkSite \MapsAndMore
[E8 Folder Connections
B water_j

MName:

£ C:\UGIs
9 ParkSite
[ SourceData
|3 ESRI.gdb
ﬁ Hydro
@ Toolboxes
[ Database Servers
[l Database Connections
@ GIS Servers
[ My Hosted Services
(3l Tracking Connections

Show of type: 1Datasets. Layers and Results

Figure 1-38



Setting map scale

By default, map scale is displayed in the form of a representative fraction,
such as 1:24,000. This means, for any unit of measure, that one unit of dis-
tance on the map is equivalent to 24,000 units in the real world. You can
set the map to any scale you want by typing a number into the scale box
and pressing Enter. You can also enter a verbal expression such as “I inch
= | mile” and it will be converted to a representative fraction. To change
the way scale is displayed, or to change the list of predefined scales, click
<Customize This List> at the bottom of the Map Scale drop-down list.

Figure 1-40 © Click the Pan tool and slowly pan eastward along the river.

Densely populated residential neighborhoods line both sides of
the river until you get to the Sepulveda Dam Recreation Area
(Figure 1-40), a large recreational area with golf courses and a lake.
The river bottom is natural here, becoming concrete again at the
Sepulveda Dam in the southeastern corner of the basin.

East of the Sepulveda Basin, the river follows a freeway for a while,
and is again surrounded by fairly dense residential and commercial
areas.

Sepulveda Dam Recreation Area ® On the keyboard, press and hold the Q key.

Now you roam continuously across the display in whichever direction
you point the mouse. To control your speed, make small brushing
movements with the mouse either with or against the direction of
movement. As you roam, the imagery should draw smoothly and
continuously, although your experience may vary. Other layers, such
as the Los Angeles River layer, suspend drawing and catch up when
you stop.

® Release the Q key to stop roaming.

> You can also use the four arrow keys on the keyboard to roam.

© Continue to pan (or roam) along the river.

The river flows generally southeast for a while, then follows the
northern edge of unincorporated Universal Studios (Figure 1-41).
It continues east, then bends sharply south as it curves around
Griffith Park (at 4,218 acres, one of the largest city parks in the
United States). To the north of Griffith Park lies the city of Burbank;
to the east is Glendale.

Figure [-41

e

As it flows south, the river runs parallel to another major freeway.
You'll see the Silver Lake Reservoir and then Elysian Park, where the
Los Angeles Dodgers play major league baseball.

Universal Studios



© Save bookmarks as place files. Dodger Stadium is a landmark

that we may want to return to.

© Center your view on Dodger Stadium, more or less as shown in

Figure 1-42.
® From the main menu, choose Bookmarks > Create Bookmark.

O In the Create Bookmark dialog box, name the bookmark Dodger
Stadium (Figure 1-43) and click OK.

Create Bookmark X

Bookmark Mame: IDodger Stadium
oK | Cancel |

Figure 1-43

Figure 1-42

Bookmarks are meant for use within a particular map document.
The two we've created so far, however, might be useful in other maps.
There’s a tool for managing saved places so that any map document
can access them: it’s called My Places and we’ll use it in Lesson 3.
For now, we’ll save our bookmarks as external files. When the time
comes, we’ll be able to load them into My Places.

©® From the main menu, choose Bookmarks > Manage

Bookmarks.

You should see two bookmarks in the [T T——————— x| Figure |-44
Bookmarks Manager, with City of Los Angeles

e
highlighted on top (Figure 1-44). g

@ Near the bottom of the Bookmarks
Manager dialog box, click

Save —> Save All.

Explore the study area
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x| The Save Bookmarks dialog box opens to the

Save in: I | MapsAndMore j [ N | af MapsAndMOfC fOldCl'.
& No fbems match your search. O In the File name box, type Lesson 1
Recent Places Places (Figure 1-45) and click Save.
[ © Close the Bookmarks Manager.
S 18) Pan to the city limits. We'll follow the
E river until it crosses the LA city limits, which

Libraries

marks the boundary of our study area.

0y

. O Pan along the river as it runs south.

This last section of river passes through an
industrial landscape and leaves the city at the
Redondo Junction train yards.

File: name: ILesson 1 Places j Save I
Saveastyps: | [ArcGIS Place File ("dat) | Cancel |
2

O Save the map.

© Ifyou're going on to the next exercise
now, leave ArcMap and Lessonl.mxd open; otherwise, from the
main menu, choose File > Exit.

Figure 1-45

Exercise |b: Do exploratory data analysis

In this exercise, we'll add park data and census data (containing
demographic and socioeconomic information) to our map. Our
goal is to pay attention to patterns in the data and thereby build
an intuitive sense of likely and unlikely locations for the park. This
intuition should give us confidence that the analysis results we get in
Lesson 6 are plausible. Conversely, if the results contradict our gut
teeling, we may be alerted to possible mistakes in the analysis.

1) Start ArcMap. We'll start ArcMap, if necessary, and continue
working with our map document from the last exercise.

O If ArcMap is open from the last exercise, go to Step 2.

O Otherwise, start ArcMap.

> You may want to pin ArcMap to your Start menu or create a
desktop shortcut to it.



In the ArcMap - Getting Started dialog box, you should see Lessonl
under the heading “Recent.”

O Click Lesson1 to highlight it (Figure 1-46) and click Open.

% ArcMap - Getting Started

Open existing map or make new map using a template

[=I- Existing Maps Recent

H rowse for more...
E| New Maps
My Templates @
E--Templahes
| Standard Page Sizes
Architectural Pag
150 (A) Page Siz Lessoni
Morth American |
= Traditional Layouts

Figure 1-46

The map opens to a view of where the LA River leaves Los Angeles
and enters the industrial city of Vernon.

2) Add alayer of parks. One of our geographic constraints is that
the new park not be located too close to existing parks. We know
there are a couple of big parks along the river, but let’s look at the
whole situation.

© On the right side of the ArcMap application window, click the
Catalog tab to open the Catalog window (Figure 1-47).
> If you don’t have this tab, on the Standard toolbar, click the
Catalog button [3].

The Catalog window lets you view and manage geographic files
on disk. The top entry in the window is your home folder, which
presently contains your map document, the layer file you saved in the
last exercise, and some graphs that are part of the starting data and
which you’ll use in Lesson 8. By default, the catalog recognizes only
alimited number of file types to help you focus on geographic data.

The Catalog window has two states. When the pin icon in the upper
right corner points sideways, the window closes if not in focus. When
the pin icon points down, the window stays open. In this state, you
can move and resize it. Leave the window in whichever state you

prefer.

O In the Catalog window, click the plus sign next to Folder
Connections to expand it.

© Expand C:\UGIS.

Click the Auto Hide
button to toggle the
window’s state

Figure |-47

Location: Iﬁ Folder Connections |Z|
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If you don’t see Los
Angeles.lyr, right-click
the Home folder and

choose Refresh.



Figure 1-48
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In figures, the Catalog window is

usually shown floating free from
ArcMap (as here).

This is the folder connection you created in the last exercise from the
Add Data dialog box.
© Expand the following items:
* ParkSite
* SourceData
* ESRI.gdb
* Landmark

The Catalog window should look like Figure 1-48.

® In the Catalog window, click Parkland to select it.

® Dragand drop Parkland anywhere over the ArcMap window.
The layer is added to the Table of Contents and the map. Dragging

and dropping data from the Catalog window is the same as adding it
with the Add Data button—it’s just faster.

3) Symbolize the layer. A shade of green is usually the right
cartographic choice for parks. ArcMap may have chosen one by
a stroke of luck, but probably not. We’ll symbolize the layer after
taking a look at its extent.

O In the Table of Contents, right-click the Parkland layer and
choose Zoom To Layer (Figure 1-49).

Figure 1-49

® In the Table of Contents, turn Parkland off and on a few times
by clicking its check box. Leave it checked on.

The data extends well beyond Los Angeles, and the basemap shows
that those big polygons to the north correspond to mountains.
They’re probably national forests. Notice that the Parkland layer is
also obscuring some of the labels on the map.

© In the Table of Contents, click the Reference layer to highlight
it. Drag it to the top of the Table of Contents (its position is
marked by a horizontal black line) and drop it above the
Parkland layer.

The labels now draw on top of the park features.



© In the Table of Contents, click the color patch under the
Parkland layer name to open the Symbol Selector (Figure 1-50).
> This is a shortcut to opening the Symbol Selector from the layer
properties.

©® In the Symbol Selector, click the Fill Color button to open the
color palette. Click Apple Dust (Figure 1-51).

©® Click the Outline Color button to open the color palette again.
Click Moss Green (Figure 1-51).

O Click OK on the Symbol Selector.

The layer symbology is updated on the map.

4) Identify features. Let’s find out what attributes this layer has.
©® On the Tools toolbar, click the Identify tool 9.

O Click on one of the big park features in the mountains to
identify it.
Among the attributes are the park’s name, its type, and its acreage
(Figure 1-52).

Identify
Identify from: I <Top-most layer> ;I
El- Parkland
- Angeles Mational Forest
B}
Location:  [-13,176,355.120 4,083,602.086 Meters o
Field | Value |
OBIECTID 1
Shape Polygon
MAME Angeles National Forest
TYPE Mational Park Service land
ACRES 448652.3
Shape_Length 2.709838
Shape_aArea | 0.177935
4| >

|Ident'ﬁed 1 feature |

Figure 1-52

© Leave the Identify window open. From the main menu, choose

Bookmarks - City of Los Angeles.
At this scale, you can make out the larger parks within the city.

© Try to locate the parks mentioned on page 28: the Sepulveda
Dam Recreation Area, Griflith Park, and Elysian Park. Click on
each with the Identify tool € to see their attributes.

® When you're done, leave the Identify window open and zoom to

the Dodger Stadium bookmark.

Figure [-50
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Figure [-53

® Identify some of the neighborhood-sized parks

in the view.
O Close the Identify window.

Our list of park requirements doesn’t have an
upper size limit, but we can expect our candidates
to be under ten acres. Our trip down the river in
the last exercise didn’t reveal any great big tracts of
open land that weren’t already parks.

5) Label parks. Some of the larger parks are
already labeled in the Reference layer, but many of
the smaller ones are not.

O In the Table of Contents, right-click Parkland

and choose Label Features.

The parks are labeled with their names in simple
black text (Figure 1-53). The information is being
taken from the NAME attribute in the Parkland
attribute table.

ArcMap places labels dynamically. The position of labels in a

view depends on the map scale, the extent, the presence of
other features, and more. The label placement in your map

may be different from what’s shown here.
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Figure 1-54

The default labels aren’t ideal for this map. The
black text disappears into the imagery wherever
the label doesn’t fit inside the park. In addition,
the labels appear on one line no matter how long
they are.

© Open the layer properties for the Parkland layer and click the
Labels tab (Figure 1-54).
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L L | Lot |

O In the Text Symbol area, click the font size drop-down arrow
and change the size from 8 to 9 (points).

© Click the color button. On the color palette, change the text
color to Lemongrass (Figure 1-55).

Lesson |: Frame the problem and explore the study area



Light green text will show up better than black, but to be legible it
will still need an outline, or halo.

® Click the Symbol button to open the Symbol Selector.

® On the Symbol Selector, underneath the properties of the cur-
rent symbol, click Edit Symbol.

O In the Editor dialog box, click the Mask tab.
© Click the Halo option and change the size to 1.

The default halo color is white, but were going to use something

darker.
© Click Symbol.
The Symbol Selector opens again.

O Click the Fill Color button and change the fill color (the halo
color) to Moss Green (Figure 1-56).

O Click OK on the Symbol Selector.
Your Editor dialog box should look like Figure 1-57.

Figure 1-57

® Click OK on all open dialog boxes.

On the map, the park labels are visible against the basemap
(Figure 1-58).
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Figure 1-56

Do exploratory data analysis
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Figure 1-59

Figure 1-60

The new symbology is a big improvement, but the labels would look
better still if the text were stacked instead of strung out in a line.
To make this change, we’ll switch from ArcMap’s default labeling
system to its advanced system.

© From the main menu, choose View > Data Frame Properties.

O In the Data Frame Properties dialog box, if necessary, click the
General tab.

The “data frame” refers generally to the map view. Data frame
properties apply to the map view as a whole or to all the layers within
it equally. You’ll work more with data frame properties in Lessons 3

and 8.

O At the bottom of the dialog box, click the Label Engine drop-
down arrow and choose Maplex Label Engine (Figure 1-59).

ArcMap has two labeling “engines.” Both place labels on the map
automatically according to a set of preferences that you can adjust.
(For example, you might want labels placed to the left of features
rather than to the right.) The Maplex Label Engine has a more
robust set of preferences than the Standard Label Engine. We won’t
explore label functionality very deeply in this book, but the Maplex
Label Engine offers one immediate advantage: it stacks label text
automatically.

@ Click OK on the Data Frame Properties dialog box.

On the map, the park labels are stacked, keeping them closer to their
features (Figure 1-60).

Lesson |: Frame the problem and explore the study area



6) Setascalerange for the labels. The park labels look good at this
fairly large scale, where there’s room to accommodate them. Let’s see
what happens when we zoom out.

© Zoom to the City of Los Angeles bookmark.

At this smaller (zoomed-out) scale, the labels overwhelm the map
(Figure 1-61). We could just turn them off, of course, whenever they
seem to be too crowded. A nicer solution is to make their visibility
dependent on the map scale.

Figure 1-61

O Open the layer properties for the Parkland layer. Click the
Labels tab if necessary.

© Near the bottom of the Labels tab, click Scale Range.
© In the Scale Range dialog box, click the “Don’t show labels when

zoomed” option.

@ Click in the “Out beyond” box and type 40, 000. ,
Figure 1-62

Whenever the map scale crosses the 1:40,000 threshold, the ScaleRange x|

park labels will turn off automatically.
You can specify the range of scales at which labels will be shown.

® Compare your Scale Range dialog box to Figure 1-62 and
click OK. Click OK again on the Layer Properties dialog

™ Use the same scale range as the feature layer.

¥ Dont show labels when zoomed:

box.
The park labels (that is, the ones that you set) disappear from R El e
the map. _
In beyond: |<None> x| (madmum scale)
® Zoom to the Dodger Stadium bookmark.
As long as the map scale is larger than 1:40,000 (which it 0K |  Cancel

should be), the labels show up again.




You've probably noticed that some parks, such as Elysian Park and
Echo Park, are labeled in both the Reference and Parkland layers.
We can set the scale range of the Reference layer reciprocally to the

Parkland labels.
© Open the layer properties for the Reference layer. Click the

General tab, if necessary.

x| This layer, being a remotely hosted map
General | Group | Display | service, has fewer properties you can set
than a layer whose source data is on your
Layer Mame: I Reference I visible
computer.
Description: ;I
© In the Scale Range area, click the
- “Don’t show layer when zoomed”
Credits: OpthIl.
S © Click in the “In beyond” box and
‘You can spedfy the range of scales at which this layer will be shown: tpr 40, 001

" Show layer at all scales

& Don't show layer when zoomed:

Qut beyond: I <Mone> vl (minimum scale)
In beyond: I 1:40,001 vl (maximum scale)

O Compare your dialog box to
Figure 1-63 and click OK.

The labels from the Reference layer
should disappear from your map. (Most
of these labels are actually for places

other than parks, but we’ll accept their

loss at large scales.)

Figure 1-63
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Figure 1-64

® Zoom back and forth across the 1:40,000 scale threshold to test
your settings.

At scales of 1:40,000 or larger, the Reference layer appears with a gray
check box in the Table of Contents (Figure 1-64). This tells you that

the layer is turned on, but is set not to show at the current map scale.

Scale ranges

As you've just seen, scale ranges can be set both for a layer’s labels and
for the layer itself. In this case, the distinction was blurred because the
Reference layer is composed of labels. But layers that are composed of
features, such as parks or rivers, can have their scale ranges set in exactly
the same way. When you design maps to be viewed at multiple scales, you
normally want layers representing detailed data, such as buildings or utility
lines, to be visible only at large (close-up) scales. You may want your map
to include multiple copies of a layer, each with a different scale range and
unigue symbology. For example, one layer might represent trees with a
generic point symbol at medium scales. A second layer might represent the
same trees with a more detailed and realistic symbol at large scales.




7) Dim the basemap. Without doing anything further to the
labels, we can emphasize them a little more by dimming the imagery
basemap. To do that, we’ll add a toolbar to the interface.

® From the main menu, choose Customize > Toolbars -
Effects.

The Effects toolbar is added (Figure 1-65). ArcMap has a lot of
special-purpose toolbars, and we’ll use several of them in this book.

I%':}Reference 8 ) e | = ‘_L}JIE-'I}D 3:

© Drag the toolbar to a position you like.
> You can dock it on the top, bottom, or either side of the ArcMap
window, or leave it undocked anywhere on your screen.
© On the Effects toolbar, click the drop-down arrow and choose
the Basemap layer.
© Click the Adjust Dim Level button <> to open a slider bar.
@ Sct the Dim Level to 10% (Figure 1-66).

On the map, the imagery fades slightly.

8) Add a layer of census tracts. The U.S. Census Bureau gathers
socioeconomic data about households and aggregates it by various
geographic units. One of these units is a census tract, which is a
relatively small subdivision of a county.

® Open the Catalog window.
© Under the SourceData folder, expand the census folder.
© Dragand drop racts.shp onto the map.

The tracts layer is added to the top of the Table of Contents. The
tracts cover everything except the Parkland labels.

© In the Table of Contents, right-click the z7acts layer and choose
Zoom To Layer.

The census tract data covers Los Angeles County, including the
islands of Catalina and San Clemente.

® Zoom to the City of Los Angeles bookmark.
@ Drag the Reference layer to the top of the Table of Contents.

Figure 1-65

Dim Level

-

10%

Figure 1-66
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Figure |-67

You may see a different set of
labels, depending on your map
scale. Map scale is affected
by things like the size of your
ArcMap window and the
resolution of your monitor.

Figure 1-68
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The tracts layer is made up of contiguous polygons that are
reminiscent of a jigsaw puzzle (Figure 1-67). Since each piece of the
puzzle represents a different set of living, breathing human beings,
it’s natural that each tract’s attribute values for population, income,
age, and so on, are different.

9) Open the attribute table. Let’s see what attributes the table has.

O In the Table of Contents, right-click the #7acts layer and choose
Open Attribute Table.

® Scroll across the table and look at the field names.

The table has some identification codes, followed by population
attributes and breakdowns of ethnicity, sex, age, household status,
and housing. Some of the field names are fairly easy to interpret,
others less so. In Lesson 2, we’ll see how to get more information
about our information by accessing metadata.

© Locate the PoP1o_sQMl field (Figure 1-68).

This attribute stores population density (people per square mile)
for the year 2010. Since one of our criteria is to locate the park in
a densely populated area, this is relevant information. The attribute
doesn’t tell us what value should be a threshold for “high density,”

but it does give us a way to start making patterns on a map.

Lesson |: Frame the problem and explore the study area



© Right-click the POP10_sQMI field name and choose Statistics
(Figure 1-69).
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Figure 1-69

The Statistics of tracts window displays summary statistics for the
field. The lowest value is O (at least one tract must be unpopulated) and
the highest is 98,150. The frequency distribution chart, or histogram,
on the right shows you that most of the values are between 0 and
about 25,000. The remaining values spread out in a long tail.

©® Close the Statistics of tracts window.
® Close the table.
10) Symbolize census tracts by population density. Symbolizing a

layer by an attribute, also called thematic mapping, allows us to see
how values are spatially distributed.

O Open the layer properties for the z7acts layer and click the
Symbology tab.

By default, all features in a layer have a single symbol (Figure 1-70).
That’s why all your census tracts are purple, or whatever color they

happen to be.
® In the Show box, click Quantities.

Layer Properties

-Generall Sourt:el Selection I Display Symbology IFields I Definition Query

Show:
F|_ " |Driln' all features using the same symbol .
f® Single symbol 5
Categories R
Quantities
| Charts
. Multiple Attributes
Click
here ~Legend
Label appearing next to the symbaol in table of co

Figure |-70



Under Quantities, four methods for symbolizing numeric attributes
are listed. The default Graduated colors method will give each feature
in the #racts layer a color that reflects its numeric value for a chosen
attribute.

O In the Fields area, click the Value drop-down list and choose
ror1o_sQumI (Figure 1-71).

zl
"General | Source | Selection | Display  Symbology | Fisids | Definion Query | Labels | Joins & Relates | Tme | HTML Popup |
Show:
Fed— |Dm-' quantities using color to show values. Import... |
Categories r— Fields Classfification
Value: |POP10_SaMI =l Natural Breaks (Jenks) <&
Momalization: Inone j Classes |5 'l Classify...
Color | T |
bol | Range | Label |
Muttivle Attributes |-2meel_| Range
iple Attributes 0.000000 - 7331.000000 0.000000 - 7331.000000
7331.000001 - 15137.500000 7331.000001 - 15137500000
15137.500001 - 25847100000 | 15137500001 - 25847.100000

I 25547100001 - 48925.000000 | 25847.100001 - 48925.000000

& T I-m.mmm-amm.mmm 48925.000001 - 98150.000000

[~ Show class ranges using featurs values Advanced -

Figure [-71

A lot is going on here. The values for the POP10_SQMI attribute,
which range from 0 to 98,150, are divided into five classes. The
starting and ending values for each class are calculated by a “natural
breaks” algorithm that separates clumps in the data. That’s why the
range of values is different from class to class and why classes break at
seemingly arbitrary numbers. Each class is associated with a symbol
in a color ramp (probably yellow to dark red, but yours may be
Figure 1-72 different if you happened to change it).

© Click Apply. Move the Layer Properties dialog
box out of the way.

On the map, the tracts are symbolized by population
density (Figure 1-72).

11) Change the classification. Quantitative
symbology is flexible, and you can present data
in many ways. Because all we want right now is
a general sense of viable areas for our project, and
because were going to look at a couple of variables
together, we should keep our presentation simple.

O In the Layer Properties dialog box, click the

Classes drop-down arrow and choose 3.




O Click Classify to open the Classification dialog box
(Figure 1-73).
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The histogram shows you the distribution of values in relation to the
current class breaks. We can change the algorithm used to set class
breaks, or make manual adjustments as desired.

O Click the Method drop-down arrow and choose Equal Interval
(Figure 1-74).
© Now set the Classification Method to Quantile.

With three classes, we’ll easily be able to see high, medium, and low
values. The Quantile method guarantees that an equal number of
tracts will fall into each class. It should be noted that there are no
inherently good or bad ways to classify data—different classifications
may be more or less appropriate to the purpose of your map and the
background knowledge of your audience.

©® In the Break Values box to the right of the histogram, click the
first class break point (7715).

The value becomes editable. At the bottom of the dialog box, a
message tells you that there are 772 elements (in this case, census
tracts) in this class.

® Replace the highlighted value with 8,000 and press Enter.
The second class break point is selected and editable.
© Replace the highlighted value (14196) with 16, @@e.

© Click in some white space in the Histogram window to stop
editing class breaks (Figure 1-75).
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At the top of the dialog box, the classification method has been reset
to Manual because we've changed the class breaks. The histogram is
updated, too. We no longer have a pure quantile classification, but
having our classes break at round numbers makes intuitive sense.

© Click OK on the Classification dialog box.

12) Change the symbology. We’'ll make some changes to the
symbology as well.

© On the Layer Properties dialog box, click the Color Ramp drop-

down arrow (or click on the ramp itself ).

© Scroll up and down to see the choices, then click the ramp again
to close the list.

© Right-click the color ramp. On the context menu, click Graphic
View to uncheck it (Figure 1-76).

v v Graphic Wiew

Toggl e Properties. ..
Color Ramp: I _j Graphic View Save to style. .
to see ramps
* by color or
Color Ramp: | Yellow to Dark Red - name
Figure |-76 I J
© Click the ramp’s name. In the drop-down list, click the Red
Light to Dark ramp to select it (Figure 1-77).
© Right-click the ramp name and choose Graphic View to show
the ramps by color again.
FileE e B Underneath the color ramp is a box with three columns:
urple-Blue Bright
Purple-Blue Light to Diark * The Symbol column shows the symbol for each class.

Purple-Red Enght

Purple-Fled Light to Diark * The Range column shows the range of values for each class.

Fed Bright _ * The Label column shows how each symbol will be described in
? EES Liggt to Dark the Table of Contents. (By default, the label matches the range.)

SEp:j e ® Click the Symbol column heading and choose Properties for All
Spectrum-Full Bright Symbols.

ngCtrum'Fu" Dark © In the Symbol Selector, click the Outline Color button. On the

pectrum-Full Light
Surface color palette, choose No Color.
Figure 177 © Click OK on the Symbol Selector.

We're taking away the outlines because we don’t need to see the tract
boundaries on the map. For now, we’re interested in them as areas,
not specifically as tracts.

© In the Label column, click on the first label (0.000000 -
8000.000000) to make it editable. Type Low and press Enter.

© Replace the second label with Medium. Press Enter.



O Change the third label to High. Click outside the edit box to
commit the edit.
©® Compare your settings to Figure 1-78 and click Apply.

Layer Properties

"Genersl | Source | Selection | Display Symbology | Fields. | Defiition Query | Labels | Joins & Relates

Feat |Dm- quantities using color to show values. Im
Categories Fields Classification
Quantities Value: |PoP10_Sami = Manual
- Graduated colors
: Hion: - : I vl Class
- Gradusted symbols || Mermalization: Inone J (S [ =2
- Proportional symbols
Dot density Color Ramp: | ~ |
Charis
Label
Multiple Attributes
s 000000 - 5000000000 Low
000007 - 16000.000000 Medium
6000.000001 - 58150.000000 High
e S

@ In the Layer Properties dialog box, click the Display tab. In the
Transparent box at the top, replace the value 0 with 50
(Figure 1-79).

O Click OK on the Layer Properties dialog box.

© In the Table of Contents, drag and drop the #7acts layer under-
neath the Los Angeles layer.

On the map, we can now see where population is concentrated along
the river, and we can see it in relation to existing parks (Figure 1-80).

Figure 1-80
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Figure 1-78
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Figure 1-79

Do exploratory data analysis
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Figure |-8
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Figure 1-83
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Line measurement (Planar)
Length: 0. 160654 Miles

Your result will depend on where you
start and end your measurement.

13) Measure distance from the river to parks. Making a few
measurements will improve our ability to estimate distance on the
map and will give us a better intuitive sense of how close to the river

the new park should be.
® Zoom to the Dodger Stadium bookmark.

© Pan the map so that a number of parks are in the view. Feel free
to zoom in or out.

® On the Tools toolbar, click the Measure tool fu to open the
Measure dialog box.

© In the row of tools at the top of the Measure dialog box, make
sure the Measure Line tool is selected (Figure 1-81).

@ Click the Choose Units button and choose Distance > Miles.

[Measure
sl 4 | T !ix' -
= .
To measure a distance, draw a line.
Confirm that Click here to
Measure Line E’ mea?.r-de an area, dick ‘Measure An Area’ then choose the
. aw a ¥aon.
is selected. measurement
To measure a feature, dick 'Measure A Feature' unit.
) then dick a feature.
Figure 1-81

On the map, the mouse pointer changes to a ruler with inscribed
crosshairs.

® Move the mouse pointer over a park, such as Cypress Park
(northeast of Dodger Stadium on the east side of the river).

The mouse pointer “snaps” to the park boundary. You can probably
feel the effect in the mouse movement. It’s confirmed on-screen by
a light gray square near the mouse pointer and a message such as

“Parkland: Vertex” or “Parkland: Edge” (Figure 1-82).
© Click to start a measurement.
© Move the mouse pointer (you don’t have to drag) to the river.

The mouse pointer snaps to the river feature. The measurement result

is displayed in the Measure dialog box (Figure 1-83).
© Double-click to end the measurement.

© Click on another park and measure its distance to the river.
The new result replaces the previous one in the Measure dialog box.

O Measure the distances from a few more parks.

Lesson |: Frame the problem and explore the study area



Cypress Park, Elysian Valley Rec Center Park, and Downey
Playground are close to the river. Elyria Canyon Park, a little over
three quarters of a mile away (at its nearest edge), stretches the notion
of proximity. Bear in mind that these measurements are straight-line
distances, not distances along streets.

©® Close the Measure dialog box.

Although the dialog box is closed, the tool stays active until another
tool is selected.

® Zoom to the City of Los Angeles bookmark.

14) Add a layer of census block groups. Another requirement for
the new park is that it be located in a lower-income neighborhood.
To symbolize an income attribute, we have to add another layer to
the map. (It’s not that income data isn’t reported at the census tract
level, it’s just that our particular #7acts layer doesn’t happen to include
it.)

® Open the Catalog window.

The same census folder that contains #racts.shp also has a dataset

called block_ groups.shp.
© Dragand drop block_groups.shp on the map.

In the Table of Contents, the new layer is added above the other
layers. Like the #racts layer, the block_ groups layer covers Los Angeles
County. And like the census tracts, the block group polygons
resemble a jigsaw puzzle. Block groups are another Census Bureau
statistical unit: theyre smaller than tracts and nest inside them.
We'll talk more about census geography in Lesson 2.

© Open the attribute table for the block_groups layer and scroll

across the attributes.

Most of these attribute names are cryptic. One of the last fields in the
table is called MEDHINC_CY (Figure 1-84). For now, take it on faith
that this stands for median household income.
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© Right-click the MEDHINC_CY field name and choose Statistics.



Figure 1-85
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The Statistics of block_groups window tells you that the lowest
value in the field is 0 and the highest is 200,001. Median value is a
midpoint. For each block group, half the households earn more than
the median income and half earn less.

® Close the Statistics of block_groups window.

® Close the attribute table.

© Drag the Reference layer to the top of the Table of Contents.
15) Symbolize census block groups by median household income.
If we symbolize the block_groups layer with graduated colors, we
won’t be able to evaluate income and population density at the same
time. Instead, we’ll represent each block group’s median household

income as a point drawn inside the block group polygon. The point
sizes will be graduated according to the income value.

© Open the layer properties for the block_groups layer and click the
Symbology tab.

® In the Show box, click Quantities. Under Quantities, click
Graduated Symbols (Figure 1-85).

O In the Fields area, click the Value drop-down list and choose
MEDHINC_CY.

© Click the Classes drop-down arrow and choose 3.
® Click Classify to open the Classification dialog box.

By coincidence, the first break point is already a nice round number
(50,000), so we don’t have to alter it.

@ In the Break Values box to the right of the histogram, click the
second class break point (94370) to make it editable.
© Replace the highlighted value with 100,000 and press Enter.

© Click in some white space in the Histogram window to stop
editing class breaks (Figure 1-86). Click OK on the

Classification dialog box.
Break Values E‘
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© In the Layer Properties dialog box, click Template (underneath
the Classify button) to open the Symbol Selector.

O In the scrolling box of symbols, click Circle 2 to select it.

O Click the Color button and change its color to Tourmaline
Green (Figure 1-87).

O Click OK on the Symbol Selector.

This sets the color and shape of the symbols that will be used to
represent income values.

O Click Background (underneath Template) to open the Symbol
Selector again.

© Change the fill color to No Color, then change the outline color
to No Color. Click OK.

This makes the block group polygons themselves invisible. All we’ll
see are the income dots spread around the map.

O In the Symbol Size boxes, replace the “from” value with 8 and the
“to” value with 24.

@ In the Label column, click on the first label (0 - 50000) to make
it editable. Type Low and press Enter.

© Replace the second label with Medium. Press Enter.
® Change the third label to High. Click outside the edit box to

commit the edit.

© Compare your settings to Figure 1-88. Click Apply and move
the Layer Properties dialog box out of the way.

At the present scale, the symbols overwhelm the map (Figure 1-89).

Figure 1-88
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16) Set a scale range for the block_groups layer. Earlier, we set
a maximum scale value for the Reference layer. Here, we’'ll set a
minimum value for the block_ groups layer.

© On the Layer Properties dialog box, click the General tab.

O In the Scale Range area, click the “Don’t show layer when
zoomed” option.

© Click in the “Out beyond” box and type 100,000 (Figure 1-90)
and click OK.

Figure |-90 | [SealeRange
‘You can specify the range of scales at which this layer will be shown:
£ show layer at all scales

" Don't show layer when zoomed:

‘Outbeyond: | 100,000 | (minimum scale) -
Inbeyond: | <None> | (maximum scale) E 2
Figure 1-91
—— The symbols disappear from the map. In the Table of Contents, the
3G layer’s check box indicates that the layer is turned on but is not visible
D £ Layers at the current map scale (Figure 1-91).
Refe .
> & o [ © Zoom to the Dodger Stadium bookmark.
o prmeL @ Click the Fixed Zoom Out button £ several times until some of
@ Medum the Medium and High symbols begin to appear.
Oran Now we can start to get a general sense of household income and
- E’”a”d population density along the river, and look at these variables in
2 @ Los Angeles relation to park locations (Figure 1-92).
= tracts
POP10_SQMI
Low
Medium
9 High
=] Los Angeles River
=] Basemap
World_Imagery

Figure 1-92 |
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17) Search for likely park areas. Clearly, we're taking an incomplete
initial look at a complex problem. We haven't considered all the
requirements (for example, the presence of children). We're not
making any exact measurements of distance. Our data classifications
are casual: we don’t yet have a good reason to say what values should
count as high population density or low median household income
in the context of our project. Nevertheless, we can form some
meaningful impressions. We won’t be able to say of an area that a
park should definitely go there, but we might be able to identify likely
and unlikely areas. Later, it will be interesting to see how well these
impressions are borne out by analysis.

© On the Standard toolbar, in the Map Scale box, highlight the
current value. Type 40,000 and press Enter.

© Pan south to where the river crosses the city boundary.

© In the Table of Contents, drag the Los Angeles River layer to the
position just below the Reference layer (Figure 1-93).

We'll follow the river to its source, marking good areas along the way.
A really good area would have these properties:

* High population density (dark red)
* Low median houschold income (small green dot)
* No existing park nearby

Table Of Contents

Eoec8

B = [N
[£] Reference
=] Los Angeles River

-
= block_aroups
MEDHIMC_CY
2 Low

O Medium

@

=] Parkland
[

=] Los Angeles

El b tracts
POP10_5QMI
Low
Medium
I High
=] Basemap
World_Imagery

Figure 1-93
* Close to the river
© Pan slowly north.
Less than a mile north of the city limits, on the east side of the river,
are a couple of tracts—one dark red and one medium red—with
small green dots (Figure 1-94). They're pretty close to the river, and
even though there are some parks in the general vicinity, it’s probably
worth marking the area.
Figure 1-94
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@ From the main menu, choose Customize > Toolbars = Draw.
The Draw toolbar is added.

@ Dock the toolbar or float it, whatever you like best.

© On the Draw toolbar, click the Drawing drop-down menu and
choose Default Symbol Properties at the bottom.
© On the Default Symbol Properties dialog box, click the Fill but-
ton to open the Symbol Selector.
© Set properties in the Symbol Selector as follows:
* Set the fill color to No Color.
* Set the outline width to 3.
* Set the outline color to Black.
©® Click OK on the Symbol Selector.

O Compare your Default Symbol Properties dialog box to
Figure 1-95 and click OK.

Figure [-95 [y Symbol Properties | x|
Marker Line Fill
— Tt rCallout

© On the Draw toolbar, click the drop-down arrow next to the
Rectangle tool. From the list of tools, choose the Ellipse tool.

® On the map, click and drag a box over the area of
interest. Release the mouse button to draw the ellipse

(Figure 1-96).

You can reshape the ellipse by dragging its selection handles. You can
move it by clicking and dragging it. The exact size and position of the
shape doesn’t matter as long as you mark the general area.

O Click off the graphic to unselect it.

Map graphics, such as these created with tools on the Draw toolbar, are dif-
ferent from features. Conceptually, features represent geographic objects
while graphics tend to be visual aids. Technically, graphics are usually stored
in map documents as annotation, not in feature classes on disk. (You'll learn
more about this in Lesson 8.) They aren't maintained as layers in ArcMap,
nor do they have attribute tables, but they can be managed from the Data
Frame Properties dialog box (Annotation Groups tab). It is possible to con-
vert features to graphics and graphics to features.

Figure 1-96




18) Continue searching for park areas. We'll keep following the
river and looking for likely places for a park.

O Pan north.

A little farther north, again on the east side of the river, is a medium-
density, lower-income area with just one park (Pecan Playground) in
the general vicinity. We’d prefer a high-density neighborhood, but
since we don’t yet have specific criteria for our analysis, we want to
be inclusive rather than exclusive in our assessments. It’s up to you
whether to mark this area or not—all that really matters is that you
start to gain a sense of the study area.

O On the Drawing menu, click the Ellipse tool and draw an ellipse
around the area (Figure 1-97).

© Unselect the graphic and keep panningalong the river.

The area opposite Dodger Stadium, on the east side of the river, is
medium-density, lower-income, and park poor.

© Draw an ellipse around this area (Figure 1-98).
You may find that the shape of the ellipse doesn’t fit the area just the

way you want.

@ On the Draw toolbar, click the Rotate button =3 .

@ Place the mouse pointer over the graphic, then click and drag to
rotate the graphic. Orient the ellipse to fit the area better.

® On the Draw toolbar, click the Select Elements tool k.
© Resize and reshape the ellipse by dragging selection handles.

You may need to switch back and forth between the Rotate and
Select Elements tool to make the ellipse look the way you want
(Figure 1-99). It’s not art, so don’t spend too much time on it.

1 Figure 1-99

Figure |

Do exploratory data analysis

98

53



© Unselect the graphic and continue panning along the river. Mark
areas that seem promising to you and reshape the ellipses as

needed.

As you navigate around Griffith Park, remember that the yellow line
marks the city limits. The areas north and east of the park aren’t part
of Los Angeles and shouldn’t be considered. Once you get around
this park, you may find fewer likely areas. But remember, there’s no
right or wrong answer for this exercise.

O After adding the last ellipse, from the main menu, choose
Edit > Select All Elements.

O Again from the main menu, choose Edit > Zoom To Selected
Elements.

O Click anywhere on the map to unselect the graphic elements
(Figure 1-100).

@ Save the map document.

Figure 1-100
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19) Export the map. We'll export this view of the

R
map to an image in TIFF format. When we finish the Save [ ), Mapsnaivor 5 e E
analysis in Lesson 6, we’ll add the image and compare o e match your search.
our guesses to the actual results. $

Recent Places
©® From the main menu, choose File > e
Export Map. -
Desktop
O At the top of the Export Map dialog box, E
click the Home #; button to navigate to the EE
Ioraries
MapsAndMore folder. i
O In the Save as type box, click the drop-down ar- —
omputer
row and choose TIFF (*.tif ). &
B ‘[:H File name: ILesson'IPredictions.tif j Save
© Replace the file name with et
. . Save as type: ITI FF (" if) 'I Cancel
LessonlPredictions.
. . - # Options
©® Under Options, click the Format tab. At the bot-
. General Fomat |
tom, check the box to write GeoT IFF tags.
Color Mode: |24-b'rt True Color j

GeoT IFF tags embed coordinate system information o = o =
into the image file. The output will be an image thar » _—
can be used in documents such as presentations or

. . . . Background Color: | v|

reports, but that will also align spatially with layers
in ArcMap. ¥ Wite GeoTIFF Tags

® Compare your Export Map dialogbox to \
Figure 1-101 and click Save.

The Export Map dialog box closes by itself.

20) Exit ArcMap. Toolbars that you leave on the : 2

interface will remain there in subsequent sessions. Figure 1-101

There’s nothing wrong with that, but too many toolbars can become
a distraction.

® From the main menu, choose Customize - Toolbars = Draw.
The Draw toolbar is removed.

© Remove the Effects toolbar in the same way.

© From the main menu, choose File > Exit.

At this point, you already have a basic working knowledge of ArcMap.
You know the problem to be solved and you have a sense of the study
area. You've worked with some of the available data for the project,
but you haven’t taken a careful, systematic look at it. That will be the
focus of the next lesson.



Symbology methods

The default Single Symbol method (under Features)
assigns the same symbol to all features in a layer. No
attribute is symbolized.

Features

Quantities o s
Charts
Multiple Attributes

Under the Categories heading are methods for sym-
bolizing descriptive attributes. Here, the Unique Values
method assigns different line widths to a roads layer ac-
cording to whether the roads are freeways, highways,
or streets.

Match to eymbals in 2
Quantities
Charts
Multiple Attributes

Under the Quantities heading are methods for symboliz-
ing numeric data. In this example, census tracts are symbol-
ized by population density. Low-density tracts are yellow,
medium-density are orange, and high-density are brown.

Features
Categories
Quantities

Graduater 3
Graduated symbols
Proportional symbols
Dot denzity

Charts

Multiple Attributes

The Charts heading has methods to compare numeric
attributes by chart symbols. These pie charts compare
percentages of owner-occupied homes (red), renter-
occupied homes (blue), and unoccupied homes (yellow)
for Southern California cities.

Features . .

Cateqories

Quantities
Charts G
Bar/Calurn

Stacked
Multiple Attributes

The Multiple Attributes heading lets you symbolize
descriptive and numeric attributes together. Here, the
descriptive attribute is vacancy. Vacant lots are orange;
developed lots are pink. The numeric attribute is land
value. A small dot in a vacant lot means the value is low;
a large dot means the value is high.

Features

Categones

Quantities

Charts

Multiple Attributes
[E] teq




